Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights.

Trademarks

The Microchip name and logo, the Microchip logo, dsPIC, KEELOQ, KEELOQ logo, MPLAB, PIC, PICmicro, PICSTART, PIC32 logo, rPIC and UNI/O are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

FilterLab, Hampshire, HI-TECH C, Linear Active Thermistor, MXDEV, MXLAB, SEEVAL and The Embedded Control Solutions Company are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, chipKIT, chipKIT logo, CodeGuard, dsPICDEM, dsPICDEM.net, dsPICworks, dsSPEAK, ECAN, ECONOMONITOR, FanSense, HI-TIDE, In-Circuit Serial Programming, ICSP, Mindi, MIWi, MPASM, MPLAB Certified logo, MPLIB, MPLINK, mTouch, Omniscient Code Generation, PICC, PICC-18, PICDEM, PICDEM.net, PICkit, PICtail, REAL ICE, rflAB, Select Mode, Total Endurance, TSHARC, UniWinDriver, WiperLock and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

All other trademarks mentioned herein are property of their respective companies.

© 2011, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

Printed on recycled paper.


Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
# Table of Contents

## Preface ....................................................................................................................... 5

1. **Introduction** ................................................................................................... 5
2. **Document Layout** .......................................................................................... 5
3. **Conventions Used in this Guide** ................................................................... 6
4. **Warranty Registration** .................................................................................. 7
5. **Recommended Reading** ................................................................................ 7
6. **The Microchip Web Site** .............................................................................. 8
7. **Development Systems Customer Change Notification Service** ............... 8
8. **Customer Support** ....................................................................................... 9
9. **Document Revision History** ......................................................................... 9

## Chapter 1. Introduction

1. **1.1 Introduction** ............................................................................................ 11
2. **1.2 Can BUS Analyzer Kit Contents** ............................................................ 11
3. **1.3 Overview Of The CAN BUS Analyzer** .................................................. 11
4. **1.4 CAN BUS Analyzer Hardware Features** .............................................. 12
5. **1.5 CAN BUS Analyzer Software** ................................................................ 14

## Chapter 2. Installation

1. **2.1 Introduction** ............................................................................................ 15
2. **2.2 Software Installation** .............................................................................. 15
3. **2.3 Hardware Installation** ............................................................................ 16

## Chapter 3. Using the PC GUI

1. **3.1 Getting Started With a Quick Setup** ....................................................... 19
2. **3.2 Trace Feature** ....................................................................................... 20
3. **3.3 Transmit Feature** .................................................................................. 21
4. **3.4 Future Feature – Group Transmit Feature** ............................................ 22
5. **3.5 Future Feature – Trace Filter Setup Feature** ........................................ 23
6. **3.6 Log File Setup Feature** ......................................................................... 24
7. **3.7 Hardware Setup Feature** ...................................................................... 25
8. **3.8 Future Feature – Saving and Retrieving the Tool Configurations** ....... 26

## Appendix A. Error Messages

## Worldwide Sales and Service .............................................................................. 30
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the Chapter Name. Items discussed in this chapter include:

• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the Chapter Name as a development tool to emulate and debug firmware on a target board. The manual layout is as follows:

• Chapter 1. “Introduction”
• Chapter 2. “Installation”
• Chapter 3. “Using the PC GUI”
• Appendix A. “Error Messages”
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

<table>
<thead>
<tr>
<th>DOCUMENTATION CONVENTIONS</th>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arial font:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td><em>MPLAB® IDE User’s Guide</em></td>
<td>...is the <em>only</em> compiler...</td>
</tr>
<tr>
<td>Emphasized text</td>
<td>the Output window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Settings dialog</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>select Enable Programmer</td>
<td></td>
</tr>
<tr>
<td>A menu selection</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
<td></td>
</tr>
<tr>
<td>Quotes</td>
<td>A menu path</td>
<td><em>File&gt;Save</em></td>
<td></td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td><em>File&gt;Save</em></td>
<td></td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click OK</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the <em>Power</em> tab</td>
<td></td>
</tr>
<tr>
<td>N’Rnnnn</td>
<td>A number in verilog format, where N is the total number of digits, R is the radix and n is a digit.</td>
<td>4'b0010, 2'hF1</td>
<td></td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
<td></td>
</tr>
<tr>
<td><strong>Courier New font:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Courier New</td>
<td>Sample source code</td>
<td>#define START</td>
<td></td>
</tr>
<tr>
<td>Filenames</td>
<td>autoexec.bat</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File paths</td>
<td>c:\mcc18\h</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keywords</td>
<td>_asm, _endasm, static</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command-line options</td>
<td>-Opa+, -Opa-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit values</td>
<td>0, 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Constants</td>
<td>0xFF, ‘A’</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic Courier New</td>
<td>A variable argument</td>
<td><em>file.o</em>, where <em>file</em> can be any valid filename</td>
<td></td>
</tr>
<tr>
<td>Square brackets []</td>
<td>Optional arguments</td>
<td>mcc18 [options] file [options]</td>
<td></td>
</tr>
<tr>
<td>Curly brackets and pipe character: {}</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>errorlevel {0</td>
<td>1}</td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td>var_name [, var_name...]</td>
<td></td>
</tr>
<tr>
<td>Represents code supplied by user</td>
<td>void main (void) { ... }</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Sending in the Warranty Registration Card entitles users to receive new product updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user's guide describes how to use the CAN Bus Analyzer on a CAN network. The following Microchip documents are available on www.microchip.com and are recommended as supplemental reference resources to understand CAN (Controller Area Network) more thoroughly.

**AN713, Controller Area Network (CAN) Basics**

This application note describes the basics and key features of the CAN protocol.

**AN228, A CAN Physical Layer Discussion**

AN754, Understanding Microchip's CAN Module Bit Timing

These application notes discuss the MCP2551 CAN transceiver and how it fits within the ISO-11898 specification. ISO-11898 specifies the physical layer to ensure compatibility between CAN transceivers.

**CAN Design Center**

Visit the CAN design center on Microchip's web site (www.microchip.com/CAN) for information on the latest product information and new application notes.
THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers and other language tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; and MPLIB™ and MPLAB LIB30 object librarians.
- **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB ICE 2000 and MPLAB ICE 4000.
- **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debugger, MPLAB ICD 2.
- **MPLAB® IDE** – The latest information on Microchip MPLAB IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager and general editing and debugging features.
- **Programmers** – The latest information on Microchip programmers. These include the MPLAB PM3 and PRO MATE II device programmers and the PICSTART® Plus and PICkit™ 2 and 3 development programmers.
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (July 2009)

• Initial Release of this Document.

Revision B (October 2011)

• Updated sections 1.1, 1.3, 1.4 and 2.3.2. Updated the figures in Chapter 3, and updated sections 3.2, 3.8 and 3.9.
Chapter 1. Introduction

1.1 INTRODUCTION

The CAN BUS Analyzer Tool is intended to be a simple-to-use, low-cost CAN Bus monitor which can be used to develop and debug a high-speed CAN network. The tool features a broad range of functions which allow it to be used across various market segments including automotive, marine, industrial and medical.

The CAN Analyzer tool supports CAN 2.0b and ISO 11898-2 (high-speed CAN with transmission rates of up to 1 Mbit/s). The tool can be connected to the CAN network using the DB9 connector or through a screw terminal interface.

The CAN BUS Analyzer has the standard functionality expected in an industry tool such as trace, transmit, trace filter, log file capability, and group CAN message transmit. All of these features make it a very versatile tool, allowing fast and simple debugging in any high-speed CAN network.

The chapter contains the following information:
- CAN BUS Analyzer Kit Contents
- Overview of CAN BUS Analyzer
- CAN BUS Analyzer Hardware Features
- CAN BUS Analyzer Software

1.2 CAN BUS ANALYZER KIT CONTENTS

1. CAN BUS Analyzer Hardware
2. CAN BUS Analyzer Software
   - The CAN BUS Analyzer software CD includes three components:
     - Firmware for the PIC18F2550 (Hex File)
     - Firmware for the PIC18F2680 (Hex File)
     - The CAN BUS Analyzer PC GUI
3. USB mini cable to connect the CAN BUS Analyzer to the PC

1.3 OVERVIEW OF THE CAN BUS ANALYZER

The CAN BUS Analyzer provides similar features available in a high-end CAN network analyzer tool at a fraction of the cost. The CAN BUS Analyzer tool can be used to monitor and debug a CAN network with an easy-to-use graphical user interface. The tool allows the user to view and log received and transmitted messages from the CAN BUS. The user is also able to transmit single or periodic CAN messages onto a CAN BUS, which is useful during development or testing of a CAN network.

Using this CAN BUS Analyzer tool has many advantages over the traditional debugging methods embedded engineers typically rely on. For example, the tool trace window will show the user the received and transmitting CAN messages in an easy to read format (ID, DLC, data bytes and timestamp).
1.4 CAN BUS ANALYZER HARDWARE FEATURES

The CAN BUS Analyzer hardware is a compact tool that includes the following hardware features. Refer to Section 1.5 “CAN BUS Analyzer Software” for more information about the software features.

**FIGURE 1-1: CAN BUS ANALYZER**

- **Mini USB Connector**
  This connector provides the CAN BUS Analyzer a communication medium to the PC, but it can also provide a power supply if the external power supply is not plugged into the CAN BUS Analyzer.
- **9-24 Volt power supply connector**
  When powered by the external power supply, the tool can be set up to disconnect from the PC to act as a periodic transmitter for CAN BUS messages. The tool can also be set up to send out a pulse upon reception of certain CAN messages, which is useful during development or debugging issues with an oscilloscope.
- **DB9 connector for the CAN BUS**
- **Termination Resistor (software controllable)**
  The user can turn ON or OFF the 120 ohm CAN bus termination through the PC GUI.
- **Status LEDs**
  Displays the USB status.
- **Trigger LED**
  Future functionality.
- **CAN Traffic LEDs**
  Shows the actual RX CAN BUS traffic from the high speed transceiver.
  Shows the actual TX CAB BUS traffic from the high speed transceiver.
- **CAN BUS Error LED**
  Shows the Error Active (Green), Error Passive (Yellow), Bus Off (Red) state of the CAN BUS Analyzer.
- **Direct access to the CAN H and CAN L pin through a screw terminal**
  Allows the user access to the CAN bus for connecting an oscilloscope without having to modify the CAN BUS wire harness.
- **Direct access to the CAN TX and CAN RX pins through a screw terminal**
  Allows the user access to the digital side of the CAN BUS transceiver.
FIGURE 1-2: CAN BUS ANALYZER SCHEMATIC
1.5 CAN BUS ANALYZER SOFTWARE

The CAN BUS Analyzer comes with two firmware hex files and PC software which provides the user with a graphical interface to configure the tool and analyze a CAN network. It has the following software tool features:

1. Trace: Monitor the CAN bus traffic.
2. Transmit: Transmit single shot, periodic, or periodic messages with a limited repeat onto the CAN bus.
3. Group Transmit: Transmit a list of CAN messages, in order, onto the CAN bus.
4. Trace Filter Setup: Configure which CAN messages from the CAN bus traffic are visible on the Trace Window.
5. Log File Setup: Save CAN bus traffic.
6. Hardware Setup: Configure the CAN BUS Analyzer for the CAN network.

**Note:** Some features will be implemented in future releases.
Chapter 2. Installation

2.1 INTRODUCTION

The following chapter describes the procedures for installing the CAN Analyzer hardware and software.

The chapter contains the following information:
- Installing CAN BUS Analyzer Software
- Installing CAN BUS Analyzer Hardware

2.2 SOFTWARE INSTALLATION

2.2.1 Installing the GUI

Install .NET framework version 3.5 before installing the CAN BUS Analyzer.

1. Run “CANAnalyzer_verXYZ.exe”, where “XYZ” is the version number of the software. By default this will install the files to: C:\Program Files\Microchip Technology Inc\CANAnalyzer_verXYZ

2. Run the setup.exe from folder: C:\Program Files\Microchip Technology Inc\CANAnalyzer_verXYZ\GUI

3. The setup will create a shortcut in the Programs Menu under “Microchip Technology Inc” as Microchip CAN Tool ver XYZ.

4. If the CAN BUS Analyzer PC software is being upgraded to a newer version, the firmware should be updated to match the revision level of the PC software. When updating the firmware, ensure that the hex files are programmed into their respective PIC18F microcontrollers on the CAN BUS Analyzer hardware.

2.2.2 Upgrading the Firmware

If upgrading the firmware in the CAN BUS Analyzer, the user will need to import the HEX files into MBLAB® IDE and program the PIC® MCUs. When programming the PIC18F2680, the user may power the CAN BUS Analyzer by external power supply or by the mini USB cable. When programming the PIC18F550, the user needs to power the CAN BUS Analyzer by external power supply. Additionally, when programming HEX files into PIC MCUs, it is recommended to check the firmware version from the GUI. This can be done by clicking on the “Help > About” menu option.
2.3 HARDWARE INSTALLATION

2.3.1 System Requirements
• Windows® XP
• .NET framework version 3.5
• USB Serial Port

2.3.2 Power Requirements
• A power supply (9 to 24 Volt) is needed when operating without the PC and when updating firmware in the USB PIC MCU
• The CAN BUS Analyzer tool can also be powered using the USB port

2.3.3 Cable Requirements
• Mini USB cable – for communicating with the PC Software
• The CAN Analyzer tool can be connected to a CAN network using the following:
  - Via the DB9 connector
  - Via screw-in terminals

2.3.4 Connecting the CAN BUS Analyzer to the PC and CAN BUS
1. Connect the CAN Analyzer via the USB connector to the PC. You will be prompted to install the USB drivers for the tool. The drivers can be found in this location:
   C:\Program Files\Microchip Technology Inc\CANAnalyzer_verXYZ
2. Connect the tool to the CAN network using the DB9 connector or the screw in terminals. Please refer to Figure 2-1 and Figure 2-2 for the DB9 connector and the screw terminals for connecting the network to the tool.

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Signal Name</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No Connect</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>CAN_L</td>
<td>Dominant Low</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>No Connect</td>
<td>N/A</td>
</tr>
<tr>
<td>5</td>
<td>No Connect</td>
<td>N/A</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>CAN_H</td>
<td>Dominant High</td>
</tr>
<tr>
<td>8</td>
<td>No Connect</td>
<td>N/A</td>
</tr>
<tr>
<td>9</td>
<td>No Connect</td>
<td>N/A</td>
</tr>
</tbody>
</table>

FIGURE 2-1: PINOUT FOR THE DB9 CONNECTOR
TABLE 2-2: 6-PIN SCREW CONNECTOR PINOUT

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Signal Names</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Vcc</td>
<td>PIC® MCU Power Supply</td>
</tr>
<tr>
<td>2</td>
<td>CAN_L</td>
<td>Dominant Low</td>
</tr>
<tr>
<td>3</td>
<td>CAN_H</td>
<td>Dominant High</td>
</tr>
<tr>
<td>4</td>
<td>RXD</td>
<td>CAN Digital Signal from Transceiver</td>
</tr>
<tr>
<td>5</td>
<td>TXD</td>
<td>CAN Digital Signal from PIC18F2680</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>Ground</td>
</tr>
</tbody>
</table>

FIGURE 2-2: PINOUT FOR THE SCREW-IN TERMINALS
Chapter 3. Using the PC GUI

Once the hardware is connected and the software is installed, open the PC GUI using the shortcut in the Programs Menu under "Microchip Technology Inc" labeled as Microchip CAN Tool ver XYZ. Figure 3-1 is a screen shot of the default view for the CAN BUS Analyzer.

**FIGURE 3-1:  CAN BUS ANALYZER DEFAULT VIEW**

3.1 GETTING STARTED WITH A QUICK SETUP

The following are setup steps to quickly start transmitting and receiving on the CAN BUS. For more details, refer to the individual sections for the different PC GUI features.

1. Connect the CAN BUS Analyzer to the PC with the mini USB cable
2. Open the CAN BUS Analyzer PC GUI
3. Open the Hardware Setup and select the CAN BUS bitrate on the CAN BUS
4. Connect the CAN BUS Analyzer to the CAN BUS
5. Open the Trace window
6. Open the Transmit Window
3.2 TRACE FEATURE

There are two types of Trace windows: Fixed and Rolling. To activate either Trace window, select the option from the main Tools menu.

**FIGURE 3-2: FIXED TRACE WINDOW**

<table>
<thead>
<tr>
<th>Trace ID</th>
<th>DLC</th>
<th>Data 0</th>
<th>Data 1</th>
<th>Data 2</th>
<th>Data 3</th>
<th>Data 4</th>
<th>Data 5</th>
<th>Data 6</th>
<th>Data 7</th>
<th>Time Stamp (sec)</th>
<th>Time Delta (sec)</th>
<th>Counter</th>
</tr>
</thead>
<tbody>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>0x1023</td>
<td>0x03</td>
<td>0x00</td>
<td>0x33</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>0x00</td>
<td>196.2752</td>
<td>0.012</td>
<td></td>
</tr>
</tbody>
</table>

**FIGURE 3-3: ROLLING TRACE WINDOW**

The Trace window displays the CAN BUS traffic in a readable form. This window will list the ID (Extended is signified with an preceding ‘x’ or Standard), DLC, DATA Bytes, the Time stamp and the time difference from the last CAN BUS message on the BUS. The Rolling Trace window will show the CAN messages sequentially as they appear on the CAN BUS. The time delta between messages will be based on the last received message regardless of CAN ID.

The Fixed Trace window will show the CAN messages in a fixed position on the trace window. The message will still be updated, but the time delta between messages will be based on the previous message with the same CAN ID.

The Trace window can also be configured with filters to show only certain IDs. This can be configured in the Trace Filter Setup (refer to Section 3.5 “Future Feature –Trace Filter Setup Feature”).
3.3 TRANSMIT FEATURE

To activate the Transmit window, select “TRANSMIT” from the main Tools menu.

The Transmit window allows the user to interact with other nodes on the CAN BUS by transmitting messages. The user is able to enter any ID (Extended or Standard), DLC or DATA Bytes combination for single message transmittal. The transmit window also allows the user to transmit a maximum of nine separate and unique messages either periodically or periodically with a limited “repeat” mode. When using the limited repeat mode, the message will be sent out at the periodic rate for a number of “repeat” times.

3.3.1 Steps to Transmit a Single-Shot Message

1. Populate the CAN message fields, which include the ID, DLC and DATA
2. Populate the Periodic and Repeat fields with “0”
3. Click on the Send button for that row

3.3.2 Steps to Transmit a Periodic Message

1. Populate the CAN message fields, which include the ID, DLC and DATA
2. Populate the Periodic field (50 ms to 5000 ms)
3. Populate the Repeat field with “0” (which translates to “repeat forever”)
4. Click on the Send button for that row

3.3.3 Steps to Transmit a Periodic Message with Limited Repeats

1. Populate the CAN message fields, which include the ID, DLC and DATA
2. Populate the Periodic field (50 ms to 5000 ms)
3. Populate the Repeat field (with a value from 1 to 10)
4. Click on the Send button for that row
3.4 FUTURE FEATURE – GROUP TRANSMIT FEATURE

To activate the Group Transmit window, select “GROUP TRANSMIT” from the main Tools menu.

FIGURE 3-5: GROUP TRANSMIT WINDOW

The Group Transmit window allows the user to interact with other nodes on the CAN BUS by transmitting messages. The user is able to transmit a limited group of messages in sequential order spaced out by user-defined timing in the Period field. All messages can be unique to each other in terms of ID, DLC, Data bytes and time between messages.

3.4.1 Steps to Transmit a Group of CAN Messages

1. Fill in the CAN message fields which include the ID, DLC and DATA for all messages that will be transmitted
2. Ensure that the Periodic field is populated for each message (50 ms to 5000 ms). This field represents the time between messages
3. Click on the Send button for that row. The row will be highlighted for the current transmitted message
3.5 FUTURE FEATURE – TRACE FILTER SETUP FEATURE

To activate the Trace Filter Setup window, select “TRACE FILTER SETUP” from the main Tools menu.

FIGURE 3-6: TRACE FILTER SETUP WINDOW

The Trace Filter Setup window allows the user to filter the Trace window for only the required IDs the user wants to view. The trace filter can match the log file filter or it can contain a completely different set of IDs.

Steps to setup the trace filter to match the log file filter
1. Make sure the Log File Filter is “Turned On”
2. Click on the “IDs Match Log File Filter” checkbox. The Trace ID Filter Setup options will become disabled
3. Click on the “Enable Trace Filter” checkbox to enable the filter
4. Confirm on the Trace window that the status of the trace filter changes from “Trace Filter Inactive” to “Trace Filter Active” (highlighted green)

Steps to setup the trace filter to be independent of the log file filter
1. Determine if the filter will work as an include or an exclude filter
2. Enter CAN IDs into the CAN ID text field and click on the “Add ID” button. Repeat this process until all CAN IDs for the filter are entered
3. Click on the “Enable Trace Filter” checkbox to enable the filter
4. Confirm on the Trace window that the status of the trace filter changes from “Trace Filter Inactive” to “Trace Filter Active (highlighted green)
3.6 LOG FILE SETUP FEATURE

To activate the Log File Setup window select “LOG FILE SETUP” from the main Tools menu.

The Log File Setup window allows the user to setup a log file of the CAN BUS traffic. This feature helps gather more information when debugging design issues, by capturing the BUS traffic when an event occurs.

Log File Setup also allows the user to setup a filter to either include or exclude user-defined IDs.

Steps to setup a log file:

1. Browse to a folder to which you want to save your log file
2. Click on the “Enable Logging” checkbox to enable writing

Steps to setup a log file with a filter:

1. Determine if the log file filter should work as an include or an exclude filter
2. Enter CAN IDs into the CAN ID text field and click on the “Add ID” button. Repeat this process until all of the CAN IDs for the filter are entered
3. Browse to a folder to which you want to save your log file
4. Click on the “Enable Logging” checkbox to enable writing
5. Confirm on the Trace window that the status of the trace filter changes from “Logging Inactive” to “Logging Active” (highlighted green)
3.7 HARDWARE SETUP FEATURE

To activate the Hardware Setup window, select “HARDWARE SETUP” from the main Tools menu.

FIGURE 3-8: HARDWARE SETUP WINDOW

The HARDWARE SETUP window allows the user to setup the CAN BUS Analyzer for communication on the CAN BUS. This feature also gives the user the ability to quickly test the hardware on the CAN BUS Analyzer.

To set up the tool to communicate on the CAN BUS:

1. Select the CAN bitrate from the drop-down combo box.
2. Click the “Set” button. Confirm bitrate has changed by viewing the bitrate setting on the bottom of the main CAN BUS Analyzer window.
3. If the CAN BUS needs the termination resistor active, then turn it ON by clicking the “Turn On” button for the Bus Termination.

Test the CAN BUS analyzer hardware:

1. Ensure that the CAN BUS analyzer is connected. You can confirm this by viewing the tool connection status on the status strip on the bottom of the main CAN BUS Analyzer window.
2. To confirm that the communication is working between the USB PIC MCU and the CAN PIC MCU, click on the “Help->About” main menu option to view the version numbers of the firmware loaded into each PIC MCU.
3.8 FUTURE FEATURE – SAVING AND RETRIEVING THE TOOL CONFIGURATIONS

3.8.1 Saving Tool Configurations

The CAN BUS Analyzer tool allows the user to save various configuration setups by the user in a particular session. The GUI will save the transmit window settings, log file settings, and screen positions of the various windows of the tool.

By choosing “Save Configuration” under the File menu, the file is saved in a default Temp folder under the default name “config.ini”.

By choosing “Save As” under the file menu, the user can define the path and name for the configuration file.

3.8.2 Retrieving Tool Configurations

Under the File menu, select “Open Configuration” and then select the desired “.ini” file to retrieve the configuration saved by the user.
## Appendix A. Error Messages

In this section, the various “pop-up” errors that are found in the GUI will be discussed in detail as to why they may occur, and the possible solutions for correcting the errors.

### TABLE A-1: ERROR MESSAGES

<table>
<thead>
<tr>
<th>Error Number</th>
<th>Error Description</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00.x</td>
<td>Trouble reading the USB firmware version</td>
<td>Unplug/plug the tool into the PC. Also make sure that the PIC18F2550 is programmed with the proper HEX file.</td>
</tr>
<tr>
<td>2.00.x</td>
<td>Trouble reading the CAN firmware version</td>
<td>Unplug/plug the tool into the PC. Also make sure that the PIC18F2680 is programmed with the proper HEX file.</td>
</tr>
<tr>
<td>3.00.x</td>
<td>ID field is empty</td>
<td>The value in the ID field cannot be empty for a message that a user is requesting to be transmitted. Enter a valid value.</td>
</tr>
<tr>
<td>3.10.x</td>
<td>DLC field is empty</td>
<td>The value in the DLC field cannot be empty for a message that a user is requesting to be transmitted. Enter a valid value.</td>
</tr>
<tr>
<td>3.20.x</td>
<td>DATA field is empty</td>
<td>The value in the Data field cannot be empty for a message that a user is requesting to be transmitted. Enter a valid value. Remember, the DLC value drives how many data bytes will be sent.</td>
</tr>
<tr>
<td>3.30.x</td>
<td>PERIOD field is empty</td>
<td>The value in the Period field cannot be empty for a message that a user is requesting to be transmitted. Enter a valid value.</td>
</tr>
<tr>
<td>3.40.x</td>
<td>REPEAT field is empty</td>
<td>The value in the Repeat field cannot be empty for a message that a user is requesting to be transmitted. Enter a valid value.</td>
</tr>
<tr>
<td>4.00.x</td>
<td>Enter the Extended ID within the following range (0x-1FFFFFFFx)</td>
<td>Enter a valid ID into the text field. The tool is expecting a hexadecimal value for an extended ID in the range of “0x-1FFFFFFFx”. When entering an extended ID, make sure to append ‘x’ onto the ID.</td>
</tr>
<tr>
<td>4.02.x</td>
<td>Enter the Extended ID within the following range (0x-536870911x)</td>
<td>Enter a valid ID into the text field. The tool is expecting a decimal value for an extended ID in the range of “0x-536870911x”. When entering an extended ID, make sure to append ‘x’ onto the ID.</td>
</tr>
<tr>
<td>4.04.x</td>
<td>Enter the Standard ID within the following range (0-7FF)</td>
<td>Enter a valid ID into the text field. The tool is expecting a hexadecimal value for a standard ID in the range of “0-7FF”. When entering an extended ID, make sure to append ‘x’ onto the ID.</td>
</tr>
<tr>
<td>4.06.x</td>
<td>Enter the Standard ID within the following range (0-2047)</td>
<td>Enter a valid ID into the text field. The tool is expecting a decimal value for a standard ID in the range of “0-2048”. When entering an extended ID, make sure to append ‘x’ onto the ID.</td>
</tr>
</tbody>
</table>
### 4.10.x Enter DLC within the following range (0-8)

Enter a valid DLC into the text field. The tool is expecting a value in the range of "0-8".

### 4.20.x Enter DATA within the following range (0-FF)

Enter valid Data into the text field. The tool is expecting a hexadecimal value in the range of "0-FF".

### 4.25.x Enter DATA within the following range (0-255)

Enter valid Data into the text field. The tool is expecting a decimal value in the range of "0-255".

### 4.30.x Enter a valid PERIOD within the following range (100-5000)\nOr (0) for a one shot message

Enter a valid Period into the text field. The tool is expecting a decimal value in the range of "0 or 100-5000".

### 4.40.x Enter a valid REPEAT within the following range (1-99)\nOr (0) for a one shot message

Enter a valid Repeat into the text field. The tool is expecting a decimal value in the range of "0-99".

### 4.70.x Unknown error caused by user input

Check that the text field only has no special characters or spaces.

### 4.75.x Required input for CAN Message is empty

Check that the ID, DLC, DATA, PERIOD, and REPEAT fields contain valid data.

### 5.00.x Reserved for Message Received Errors

Reserved for Message Received errors.

### 6.00.x Unable to Log Data

Tool is unable to write CAN traffic to Log File. Possible cause may be that the drive is either full, write protected, or does not exist.

<table>
<thead>
<tr>
<th>Error Number</th>
<th>Error</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.10.x</td>
<td>Enter DLC within the following range (0-8)</td>
<td>Enter a valid DLC into the text field. The tool is expecting a value in the range of &quot;0-8&quot;.</td>
</tr>
<tr>
<td>4.20.x</td>
<td>Enter DATA within the following range (0-FF)</td>
<td>Enter valid Data into the text field. The tool is expecting a hexadecimal value in the range of &quot;0-FF&quot;.</td>
</tr>
<tr>
<td>4.25.x</td>
<td>Enter DATA within the following range (0-255)</td>
<td>Enter valid Data into the text field. The tool is expecting a decimal value in the range of &quot;0-255&quot;.</td>
</tr>
<tr>
<td>4.30.x</td>
<td>Enter a valid PERIOD within the following range (100-5000)\nOr (0) for a one shot message</td>
<td>Enter a valid Period into the text field. The tool is expecting a decimal value in the range of &quot;0 or 100-5000&quot;.</td>
</tr>
<tr>
<td>4.40.x</td>
<td>Enter a valid REPEAT within the following range (1-99)\nOr (0) for a one shot message</td>
<td>Enter a valid Repeat into the text field. The tool is expecting a decimal value in the range of &quot;0-99&quot;.</td>
</tr>
<tr>
<td>4.70.x</td>
<td>Unknown error caused by user input</td>
<td>Check that the text field only has no special characters or spaces.</td>
</tr>
<tr>
<td>4.75.x</td>
<td>Required input for CAN Message is empty</td>
<td>Check that the ID, DLC, DATA, PERIOD, and REPEAT fields contain valid data.</td>
</tr>
<tr>
<td>5.00.x</td>
<td>Reserved for Message Received Errors</td>
<td>Reserved for Message Received errors.</td>
</tr>
<tr>
<td>6.00.x</td>
<td>Unable to Log Data</td>
<td>Tool is unable to write CAN traffic to Log File. Possible cause may be that the drive is either full, write protected, or does not exist.</td>
</tr>
</tbody>
</table>
### Worldwide Sales and Service

**AMERICAS**

**Corporate Office**
2355 West Chandler Blvd. Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support: [http://www.microchip.com/support](http://www.microchip.com/support)
Web Address: [www.microchip.com](http://www.microchip.com)

- **Atlanta**
  - Duluth, GA
  - Tel: 678-957-9614
  - Fax: 678-957-1455

- **Boston**
  - Westborough, MA
  - Tel: 774-760-0087
  - Fax: 774-760-0088

- **Chicago**
  - Itasca, IL
  - Tel: 630-285-0071
  - Fax: 630-285-0075

- **Cleveland**
  - Independence, OH
  - Tel: 216-447-0464
  - Fax: 216-447-0643

- **Dallas**
  - Addison, TX
  - Tel: 972-818-7423
  - Fax: 972-818-2924

- **Detroit**
  - Farmington Hills, MI
  - Tel: 248-538-2250
  - Fax: 248-538-2260

- **Indianapolis**
  - Independence, OH
  - Tel: 317-773-8323
  - Fax: 317-773-5453

- **Los Angeles**
  - Mission Viejo, CA
  - Tel: 949-462-9523
  - Fax: 949-462-9608

- **Santa Clara**
  - Santa Clara, CA
  - Tel: 408-961-6444
  - Fax: 408-961-6445

- **Toronto**
  - Mississauga, Ontario, Canada
  - Tel: 905-673-0699
  - Fax: 905-673-6509

**ASIA/PACIFIC**

**Asia Pacific Office**
Suits 3707-14, 37th Floor Tower 6, The Gateway Harbour City, Kowloon Hong Kong
Tel: 852-2401-1200
Fax: 852-2401-3431

- **Australia - Sydney**
  - Tel: 61-2-9868-6733
  - Fax: 61-2-9868-6755

- **China - Beijing**
  - Tel: 86-10-8596-7000
  - Fax: 86-10-8528-2104

- **China - Chengdu**
  - Tel: 86-28-8665-5511
  - Fax: 86-28-8665-7889

- **China - Chongqing**
  - Tel: 86-23-8980-9588
  - Fax: 86-23-8980-9500

- **China - Hangzhou**
  - Tel: 86-571-2819-3187
  - Fax: 86-571-2819-3189

- **China - Hong Kong SAR**
  - Tel: 86-25-2401-1200
  - Fax: 86-25-2401-3431

- **China - Nanjing**
  - Tel: 86-25-8473-2460
  - Fax: 86-25-8473-2470

- **China - Qingdao**
  - Tel: 86-532-8502-7355
  - Fax: 86-532-8502-7205

- **China - Shanghai**
  - Tel: 86-21-5407-5533
  - Fax: 86-21-5407-5066

- **China - Shenyang**
  - Tel: 86-24-2334-2829
  - Fax: 86-24-2334-2393

- **China - Shenzhen**
  - Tel: 86-755-8203-2660
  - Fax: 86-755-8203-1760

- **China - Wuhan**
  - Tel: 86-27-5980-5300
  - Fax: 86-27-5980-5118

- **China - Xian**
  - Tel: 86-29-8833-7252
  - Fax: 86-29-8833-7256

- **China - Xiamen**
  - Tel: 86-592-23881338
  - Fax: 86-592-2388130

- **China - Zhuhai**
  - Tel: 86-756-3210040
  - Fax: 86-756-3210049

**ASIA/PACIFIC**

- **India - Bangalore**
  - Tel: 91-80-3090-4444
  - Fax: 91-80-3090-4123

- **India - New Delhi**
  - Tel: 91-11-4160-8631
  - Fax: 91-11-4160-8632

- **India - Pune**
  - Tel: 91-20-2566-1512
  - Fax: 91-20-2566-1513

- **Japan - Yokohama**
  - Tel: 81-45-471-6166
  - Fax: 81-45-471-6122

- **Korea - Daegu**
  - Tel: 82-53-744-4301
  - Fax: 82-53-744-4302

- **Korea - Seoul**
  - Tel: 82-2-554-7200
  - Fax: 82-2-558-5932

- **Malaysia - Kuala Lumpur**
  - Tel: 60-3-6201-9857
  - Fax: 60-3-6201-9859

- **Malaysia - Penang**
  - Tel: 60-4-227-8870
  - Fax: 60-4-227-4068

- **Philippines - Manila**
  - Tel: 63-2-634-9065
  - Fax: 63-2-634-9069

- **Singapore**
  - Tel: 65-6334-8870
  - Fax: 65-6334-8850

- **Taiwan - Hsin Chu**
  - Tel: 886-3-5778-366
  - Fax: 886-3-5770-955

- **Taiwan - Kaohsiung**
  - Tel: 886-7-536-4818
  - Fax: 886-7-330-9305

- **Taiwan - Taipei**
  - Tel: 886-2-2500-6610
  - Fax: 886-2-2508-0102

- **Thailand - Bangkok**
  - Tel: 66-2-694-1351
  - Fax: 66-2-694-1350

**EUROPE**

- **Austria - Wels**
  - Tel: 43-7242-2244-39
  - Fax: 43-7242-2244-393

- **Denmark - Copenhagen**
  - Tel: 45-4450-2828
  - Fax: 45-4485-2829

- **France - Paris**
  - Tel: 33-1-69-53-63-20
  - Fax: 33-1-69-30-90-79

- **Germany - Munich**
  - Tel: 49-89-627-144-0
  - Fax: 49-89-627-144-44

- **Italy - Milan**
  - Tel: 39-0331-742611
  - Fax: 39-0331-466781

- **Netherlands - Drunen**
  - Tel: 31-416-690399
  - Fax: 31-416-690340

- **Spain - Madrid**
  - Tel: 34-91-708-08-90
  - Fax: 34-91-708-08-91

- **UK - Wokingham**
  - Tel: 44-118-921-5869
  - Fax: 44-118-921-5820

08/02/11